Poglavje 3
SUPB in nacini dostopa do podatkov



SUPB in nacini dostopa do podatkov

= SUPB: kompleksna zbirka programov, ki v okviru
podatkovnega sistema skrbijo za podatke in
zagotavlja uporabnikom dostop do njih.

= Glavni nalogi SUPB:

— upravljanje s podatkovno bazo glede na potrebe razlicnih skupin
uporabnikov

— skrb za razpoloZljivost in celovitost shranjenih podatkov.

Podatkovni sistem Podatki (SUPB je osencen)

Strojna Programska Nadini L
Uporabniki
oprema oprema uporabe




Uporabniki podatkovne baze

= Uporabniki uporabljajo SUPB na najrazlicnejse nacine.
= Glede na vloge, v katerih nastopajo, jih delimo na
nekaj tipicnih skupin:
— Naivni uporabniki

— Parametricni uporabniki
— Menujsko vodeni uporabniki

— Povprasevalni uporabniki
— Uporabniski programeriji

— Sistemski programer;ji

— Administrator(ji) podatkovne baze



Uporabniki podatkovne baze

= Naivni uporabniki
— obcasen dostop do podatkovne baze

— namenske, enostavne aplikacije (tudi glede interakcije s podatkovno bazo),
ki pretezno temeljijo na obrazcih.

— pogosto spletne in mobilne aplikacije: eBay, YouTube, ...



Uporabniki podatkovne baze

= Parametricni uporabniki

dostopajo do podatkovne baze z uporabo aplikacij, napisanih v
sploSnonamenskih programskih jezikih

pri zagonu teh programov je potrebno po navadi specificirati vrsto
parametrov oziroma vhodnih podatkov

delo s programi je preprosto, interakcija s podatkovno bazo pa lahko
poljubno zapletena,

zakrivajo kompleksnost dejanskih operacij

SCitijo podatkovno bazo pred morebitnimi napacnimi vnosi podatkov
(kontrola vhodnih podatkov) in postopki dela

uporaba predvsem pri rutinskih uporabah podatkovne baze (npr. v
bancnistvu, rezervacijskih sistemih, ...)



Uporabniki podatkovne baze

= Menujsko vodeni uporabniki

dostopajo do podatkov s pomocjo menujsko vodenega dialoga pod
nadzorom SUPB

le obcasno potrebujejo dostop do podatkov in zato niso podrobneje
seznanjeni s funkcijami in lastnostmi SUPB

predvsem potrebujejo dostop do podatkov, le redko tudi azuriranje
menujski vmesnik omogoca gradnjo kompleksnih poizvedb brez
poznavanja povprasevalnega jezika (npr. SQL)

podatkovne potrebe so nepredvidljive in spontane, tako da jih ni mozno
reSevati z vnaprej pripravljenimi uporabniskimi programi



Uporabniki podatkovne baze

= Povprasevalni uporabniki
— SUPB uporabljajo pogosto in na razliéne nacine

— za dostop do podatkov pa uporabljajo povprasevalne jezike SUPB
(predvsem SQL)

— poznajo tako ukaze jezika, kot tudi strukturo in vsebino podatkovne baze.

— ukaze povprasevalnega jezika uporabnik zaporedoma interaktivno
posreduje SUPB, ali pa jih (pri kompleksnejsih povprasevanijih) zbere v
ukazni datoteki, ki jo posreduje SUPB v paketno (ang. batch) izvajanje.



Uporabniki podatkovne baze

= Uporabniski programeriji
— piSejo programe za parametri¢ne uporabnike glede na njihove potrebe in zahteve

— glede na pogosto ponavljajoce se dostope v podatkovno bazo, je pomembno
zagotoviti ucCinkovitost teh programov

— obicajno pisani v splosSnonamenskih programskih jezikih, ki omogocajo bistveno
hitrejSe izvajajnje od programov pisanih v povprasevalnih jezikih.

— dostop do podatkovne baze preko ustreznih programskih vmesnikov



Uporabniki podatkovne baze

= Sistemski programerji
— vzdrzujejo SUPB po navodilih proizvajalca

— razvijajo sploShonamenske programe in aplikacije za vse uporabnike
podatkovne baze.

— razvijajo in vzdrzujejo tudi spletne in aplikacijske vmesnike za menujsko
vodene uporabnike (z orodji proizvajalca)



Uporabniki podatkovne baze

= Skrbnik podatkovne baze (DBA) skrbi za razpolozljivost,
celovitost in uporabnost podatkov v podatkovni bazi.
Poglavitne naloge DBA so:

definiranje in azuriranje notranjih, konceptualnih in zunanjih shem
kreiranje in inicializacija fizicne podatkovne baze

razvoj in vzdrzevanje programskih orodij za podporo koncnim uporabnikom
in uporabniskim programerjem

zaSCita podatkovne baze pred nesreCami in njeno obnavljanje
postopki za vzdrzevanje kvalitete podatkovne baze
upravljanje sistema gesel in dostopnih dovoljenj za uporabnike



Uporabniki podatkovne baze

= Skrbnik podatkovne baze (DBA)

— nadzorovanje zmogljivosti in uporabe podatkovne baze ter izvajanje
ustreznih reorganizacij in prilagoditev (uglasevanije)

— pomoc uporabnikom pri nacrtovanju in uporabi podatkov ter uporabi
programskih orodij v okviru SUPB

— administratorske naloge lahko opravlja ena ali ve€ oseb

— v manjsSih okoljih se lahko nekatere naloge upravitelja podatkovne baze,
kot so kreiranje shem in izdaja pristopnih dovoljenj za lastne podatke
prenesejo tudi na koncne uporabnike



Dostop do podatkovne baze

= Razlicne skupine uporabnikov do podatkov dostopajo na razlicne
nacine

Odjemalec Mobilni % Streznik =
t:jr:gza odjemalec OdjemAalec e E‘
Saka s trdim
diskom
Odjemalec
In streznik
Lokacija 1 Lokacija 2 Lokacija 3 Lokacija 4 Lokacija N

Komunikacijsko omrezje




Dostop do podatkov: podatkovni vmesniki

= Menujski in spletni vmesniki:
— aplikacije za menujske uporabnike,
— vodenje korak za korakom
— dejanski ukaz se gradi postopoma

= Obrazci (forms):
— Naivni uporabniki
— Vnos in spreminjanje podatkov
— Kontrola podatkov in z njimi povezane transakcije
= Graficni uporabniski vmesniki
— Podatkovna baza kot simbolicen diagram podatkovnih objektov
— Uporabnik doloci operacijo s klikanjem po diagramu (QBE)



Dostop do podatkov: podatkovni vmesniki

= Vmesniki z uporabo naravnega jezika
— Postavljanje vprasanj v poenostavljenem naravnem jeziku (obicajno anglescini)
— Potrebna pazljivost zaradi moznih dvoumnosti

= Vmesniki za parametricne uporabnike
— Relativno majhno Stevilo pogostih operacij
— Moznost nastavljanja parametrov delovanja
— Hiter zagon (kombinacija tipk na terminalu)
— Strogo namenske aplikacije

= Vmesniki za skrbnike PB
— Izvajanje privilegiranih ukazov
— Vpogled v delovanje SUPB, moznost reorganizacije



Dostop do podatkov: podatkovni jeziki

= Povprasevalni uporabniki in programeriji

= Nizkonivojski postopkovni
— Bolj ali manj splosnonamenski programski jeziki

— Zapisno usmerjeni: podatke definirajo in do njih dostopajo preko programskih
konstruktov (zank)

— V uporabi le Se v starih (legacy) aplikacijah

= Visokonivojski nepostopkovni (npr. SQL)
— DDL in DML: samostojna uporaba za opis kompleksnih operacij znotraj SUPB
— Moznost vklju¢evanja (embedding) v sploSnonamenske programske jezike s

posebnimi orodji
— Uporaba v splosnonamenskih programskih jezikih z uporabo programskih vmesnikov



Programski dostop do podatkovne baze

Dostop do podatkov iz poljubnega programa o0z. programskega
jezika (odjemalca):

— Samostojne aplikacije (Python, C#, C++, Java, ...)

— Spletne aplikacije (PHP, Java, Ruby, Python, ..., JavaScript?)

— Mobilne aplikacije (Java, Kotlin, Swift, ...)

— Nekateri splosSnonamenski programi (Excel, Access, Word, ...)

Vsak SUPB definira lastne protokole za ¢cim-ucinkovitejso
komunikacijo odjemalec/streznik

VkljuCeni (embedded) SQL: predprocesirana programska koda
Obstoj splosnih komunikacijskih standardov



VkljucCeni (embedded) SQL

= Poseben predprocesor,
podprt s strani proizvajalca
SUPB, preoblikuje izvorno
kodo in jo posreduje
prevajalniku

= Primer v programskem
jeziku C

EXEC SQL BEGIN DECLARE SECTION;
int jid;
int cid;
VARCHAR dan[20];

EXEC SQL END DECLARE SECTION;

int main()

jid = 49;
cid = 103;
dan="2010-04-04";

EXEC SQL INSERT INTO
rezervacija(jid, cid, dan)
VALUES (:jid, :cid, TO_DATE (:dan));
EXEC SQL COMMIT WORK;



Komunikacija od aplikacije do podatkovne baze

Aplikacija

A

Y

Aplikacijski programski vmesnik (API)

A A A

Razli¢ni komunikacijski protokoli

Y Y

Podatkovna

baza Sybase MSQL

J9jewalpo

IUZAAS



Nastanek standardnih programskih vmesnikov

= Razlicni proizvajalci podatkovnih baz uporabljajo razlicne
protokole in programske vmesnike (API)

* Tezavno programiranje aplikaci

» Leta 1992 se pojavi vmesnik ODBC (open data base connectivity),
Ki skuSa poenotiti programski dostop

» Aplikacije prenosljive na razlicne platforme, vendar je njihova

funkcionalnost in u€inkovitost nekoliko okrnjena v primerjavi z
uporabo originalnih programskih vmesnikov



ODBC - open data base connectivity

= Nastal je leta 1992 v sodelovanju Microsofta s podjetjem Simba
Technologies

= Sloni na razliénih standardnih Call Level Interface (CLI)
specifikacijah iz SQL Access Group, X/Open in ISO/IEC

= Leta 1995 je ODBC 3.0 postal del standarda ISO/IEC 9075-3 --

Information technology -- Database languages -- SQL -- Part 3:
Call-Level Interface (SQL/CLI).




ODBC

* Prevzeli so ga vsi pomembnejsi proizvajalci SUPB

= Mnozica implementacij ODBC gonilniskih sistemov za
razlicne operacijske sisteme in SUPB-je:

Microsoft ODBC (DAO, DAC: data access objects, data access
components),

IODBC (open source: MacOS, Linux, Solaris, ...),

IBM i5/0S (IBM, DB2),

UnixODBC (open source: Linux),

UDBC (predhodnik iODBC, zdruzuje ODBC in SQL access group CLI)
Oracle, Informix, Sybase, MySQL, ... za razlicne OS



Znacilnosti ODBC

* Proceduralni programski vmesnik za dostop do podatkovne baze
* Omejitev ODBC: delo z SQL standardom, kot ga definira ODBC

» Tezaven dostop do specificnih razSiritev SQL: omogocCen s
pomocjo meta-podatkovnih funkcij

» Kaj potrebujemo za delo: ODBC aplikacijski vmesnik za nas OS in
ODBC gonilnik za nas OS in uporabljano PB



Zakaj ODBC?

Aplikacije niso vezane na konkreten API

SQL stavke lahko v kodo vkljuCujemo statiCno ali dinamicno
= Aplikacij ne zanima dejanski komunikacijski protokol
Format podatkov prilagojen programskemu jeziku

» Standardiziran vmesnik (X/Open, ISO CLI)

» Univerzalno sprejet in podprt



Kaj nam ODBC ponuja

= Knjiznico funkcij, ki omogoca aplikaciji povezavo s SUPB, izvajanje
SQL stavkov in dostop do rezultatov in statusa izvajanja
Standarden nacin za prijavo in odjavo na SUPB

Standardno (a omejeno) predstavitev podatkovnih tipov
Standarden nabor sporocil o napakah

Podporo sintaksi SQL po X/Open in ISO CLI specifikacijah



Arhitektura ODBC

= AplikaCije: _ﬁ i:B:‘. Erab'ed Appliczticns I

— procesiranje podatkov,

— klici ODBC funkcij za posredovanje
poizvedb in rezultatov

= ODBC upravljalec gonilnikov: —

— Nalaga gonilnike glede na potrebe
aplikacij

)
il
i)
&

4> QINEC Driver Fdarlégerl

.

=

— Procesira klice ODBC funkcij in jih

ODEC Driver
posreduje gonilniku @



Arhitektura ODBC
= ODBC gonilnik; ————————————————— o

— Prevzema klice ODBC funkcij, jih po @ @ @ @

potrebi preoblikuje in posreduje SUPB
— Omogoca manjkajoco funkcionalnost

>

glede na implementiran ODBC standard SDEC Drfver Mancgar |
= Podatkovni vir: |
— SUPB 2> CDECTriver )

— tekstovne datoteke

— preglednice E%



ODBC in standardni SQL

= ODBC standardizira tako aplikacijski vmesnik (API) kot tudi
podporo SQL ukazom

= Popolna podpora od ODBC 3.0 dalje:
— Minimalni SQL
— Standardni SQL (X/Open, ISO CLI)
— RazSirjeni SQL



ODBC in standardni SQL

= Minimalni SQL
— Data Definition Language (DDL): CREATE TABLE in DROP TABLE

— Data Manipulation Language (DML): enostavni SELECT, INSERT, UPDATE, in
DELETE z iskalnim pogojem

— Preprosti izrazi: (npr. as A>B+C)
— Samo znakovni podatkovni tipi: CHAR, VARCHAR, LONG VARCHAR



ODBC in standardni SQL

= Standardni SQL
— Vsebuje minimalni SQL
— Data Definition Language (DDL): ALTER TABLE, CREATE INDEX, DROP
INDEX, CREATE VIEW, DROP VIEW, GRANT, in REVOKE
— Data Manipulation Language (DML): polni SELECT stavek
— Izrazi: gnezdene poizvedbe, skupinski operatorji (npr. SUM, MIN, ...)

— Podatkovni tip: DECIMAL, NUMERIC, SMALLINT, INTEGER, REAL, FLOAT,
DOUBLE PRECISION



ODBC in standardni SQL

= Razsirjeni SQL

Minimalni in osnovni SQL
Data Manipulation Language (DML): zunaniji stiki, pozicijski UPDATE, pozicijski
DELETE, SELECT FOR UPDATE, unije

Izrazi: skalarne funkcije (npr.SUBSTRING, ABS), doloCila za deklaracijo konstant
DATE, TIME in TIMESTAMP

Podatkovni tipi: BIT, TINYINT, BIGINT, BINARY, VARBINARY, LONG VARBINARY,
DATE, TIME, TIMESTAMP

Paketi SQL stavkov
Podpora shranjenim proceduram (klicanje)

= ODBC "pass through": posreduje SQL ukaze direktno v SUPB brez
preverjanja pravilnosti (pogosto privzeto, tudi pri pyodbc)



Predpriprava na uporabo ODBC

= SUPB s podatki
= Aplikacijo, ki zna uporabljati ODBC (npr. Microsoft Excel)

= ODBC gonilnik za izbrani OS (32/64 bit)in SUPB
— MySQL: Connector/ODBC
— Oracle: Oracle Instant Client



Priprava podatkovnega vira (Oracle)

= QOdprite Control Panel->Administrative tools->ODBC Data Sources
(64-bit), (redkeje 32-bit, odvisno od vasega sistema in orodij)

= V zavihku User DSN izberite Add in nato dolocCite ODBC gonilnik:

— Oracle in
instantclient_XY_Z
(oznaka verzije)

— Vnesite vrednosti s
slike: DSN je lahko
poljuben.

— User ID je lahko:
ime/geslo

User ID

Enable Result Sets

Enable Closing Cursors

Batch Autocommit Mode

Numeric Settings

Application | Oracle | Workarounds | SQLServer Migration

v| Enable Query Timeout |¥| Read-Only Connection

Enable Thread Safety |V

[ |
Oracle ODBC Driver Configuration & J
Data Source Name FRI
TNS Service Name todo. fri.unil. sifvaje - [L

| Test Connection |

[Commi‘t only if all statements succeed

{Use Oracle NLS settings




Priprava podatkovnega vira (MySQL)

= QOdprite Control Panel->Administrative tools->ODBC Data Sources
(64-bit), (redkeje 32-bit, odvisno od vasega sistema in orodij)

[ MySQL Connector/ODBC Data Source Conﬁgurationl___ L@J ﬁ
= V zavihku User DSN S DEC O “
izberite Add in nato |
dolocite ODBC gonilnik: | |
— MySQL ODBC X.Y driver ) Description:
- VneSIte VreanStI S Server: localhost Port: 3306
slike: DSN je lahko S
poljuben. T
— Lahko vnesete uporab. Dotabase:  vale - [ae )
ime in geslo
OK ‘ [ Cancel H Help ]




Uporaba ODBC za povezavo s PB

= Povezava na PB iz programskega jezika (Python/pyodbc)
= Povezava na PB iz primerne aplikacije (Microsoft Excel)

= Vec detajlov o uporabi s primeri boste videli na vajah!



Microsoft Excel in ODBC

= [zberite
Data &> Get Data > From Other Sources = From Microsoft Query

= Jzberite vir podatkov, kot definirano v ODBC Data Sources (npr. FRI)

Databases I Queriesl OLAP Cubes

<New Data Source>
dBASE Files™
DOMA>

Excel Files™ Browse...
_
MS Access Database™ Options...
pb64*
pbms_" Delete
pbvaje*
P PR a b ]

[ Use the Query Wizard to create/edit queries




Microsoft Excel in ODBC

Jadralec(jid, ime, rating, starost)
Coln(cid, ime, dolzina, barva)
Rezervacija(jid, cid, dan)

= Ne izberite nobene tabele (gumb Close)

= Jzberite File->Execute SQL

= Vnesite SQL poizvedbo in pritisnite gumb Execute

okolju (SQL Developer,

omejitev.

-

/SQL poizvedbo je smiselno napisati
in preveriti v za to namenjenem

Workbench) ob upostevanju ODBC

Execute SQL [ o]
SOL statement: , '5
SELECT * meewe
FROM coln c, rezervacija r
WHERE c.cid = dcid
I
Open... I
Save... I
Procedures... I
Data Sources... |FFlI
e




Microsoft Excel in ODBC

# Microsoft Query e e X
.
Edit View Format Table Criteria Records Window Help
New... n
Open...
Close
Seve 0 Quent B
S/ | CID | IME | DOLZINA | BARVA | JID | CID | DAN
Ve b | Elan 34 modra 22 101 2006-10-10 00:00:00
. |12 Elan 34 rdeca 22 102 2006-10-10 00:00:00
Table Definition... __ |03 Sun Odyssey 37 zelena 22 103 2006-10-08 00:00:00
Execute SQL... __|104 Bavaria 50 rdeca 22 104 2006-10-07 00:00:00
|12 Elan 34 rdeca N 102 2006-11-10 00:00:00
S ———— e |13 Sun Odyssey 37 zelena N 103 2006-11-06 00:00:00
. __|104 Bavaria 50 rdeca N 104 2006-11-12 00:00:00
{ Return Data to Microsoft Office Excel _ | Elan 34 modra 64 101 2006-09-05 00:00:00
__|102 Elan 34 rdeca 64 102 2006-09-08 00:00:00
__J103 Sun Odyssey 37 zelena 74 103 2006-09-08 00:00:00
W[ [Recod]T — [¥]M]
4 m »
Create or open a query or a table definition NUM

= Jzberite File->Return Data to Microsoft Excel
=V Excelu dobite tabelo z rezultatom

= QOdvisno od definicije DSN (z ali brez gesla) je obCasno potrebno
vnesti ime in geslo za dostop do podatkovne baze



Rezultat poizvedbe v Excelu

B E S - Book1 - Excel ?7E - & X
HOME INSERT PAGELAYOUT FORMULAS DATA REVIEW VIEW LOADTEST ACROBAT TEAM Signin
13 Je v
A B C D E F G H I

T glid gdan gime gdolzina gbarva

2 101 22 10.10.2006 Elan 34 modra ]

3 102 22  10.10.2006 Elan 34 rdeca ]

4 103 22 8.10.2006 Sun Odyss 37 zelena

5 104 22 7.10.2006 Bavaria 50 rdeca

6 102 31 10.11.2006 Elan 34 rdeca

7 103 31 6.11.2006 Sun Odyss 37 zelena

8 104 31 12.11.2006 Bavaria 50 rdeca

9 101 64 5.09.2006 Elan 34 modra

10 102 64 8.09.2006 Elan 34 rdeca

11 103 74 8.09.2006 Sun Odyss 37 zelena

2] W - }—+ 228%
m O wm B @ 9 B £ & B Baze © A~ m ) ENG 07413 [ ]




Microsoft Excel in ODBC

= Povezave s podatkovno bazo so "zive"

— S pritiskom na Data->Refresh All osvezimo vsebino rezultata
poizvedbe

= Urejanje poizvedb
— Pritisnite Data->Existing Connections
— Izberite ustrezno poizvedbo in pritisnite Open

r
Existing Connections @M

Show: | Connections in this Workbook |Z]

Select a Connection:

Queryl
[Blank]

[ Browse for More... ] Open ]




Microsoft Excel in ODBC

— Izberite Properties in nato
zavihek Definition

— V okencu Command text ali s
klikom na Edit Query lahko
popravimo poizvedbo

-

Y EA™)

Import Data

Select how you want to view this data in your workbook.
ﬁ @ Table

34l © pivotTable Report
i3] O PivotChart and PivotTable Report
Er) Only Create Connection

Where do you want to put the data?
@) Existing worksheet:

%
) New worksheet

Properties... | D ok

| [ concel ]

P

Connection Properties

Connection name: |Query1l
Description:
Usage | Definition
Connection type: Database Query
Connection file: Browse..
Always use connection file
Connection string: | pSN=FRI;UID=pb;;DBQ=TODO.FRI.UNI- ~

LJ).SI:1521/VAJE;DBA=W;APA=T;EXC=F;FEN=T;QT
O=T;FRC=10;FDL=
10;LOB=T;RST=T;BTD=F;BNF=F;BAM=IfAllSuccess ~

[] save password
Command type: SQL
Command te Select * from

rezervadjar, coln ¢
where r.dd = c.ad

Excel Services:

| Authentication Settings... |

[ Edit Query... | ) | Export Connection Fi... |




Microsoft Excel in ODBC

= NovejSe razliCice Excela ponujajo tudi druge moznosti

— Direktno iz baze: From Database -> From XYZ

= Poleg ODBC gonilnika potrebujemo tudi ustrezno .NET podporo (npr. za MySQL
Connector/ODBC in Connector/NET)

= Ustvari novo povezavo na bazo
» Prenos celih tablel ali rezultata poizvedbe (Advanced options)

— Direktno iz ODBC: From Other Sources -> From ODBC
» Izbor iz predefiniranih virov ODBC
* Prenos celih tabel ali rezultata poizvedbe (Advanced options)
— Launch Power Query Editor (naslednik Microsoft Query-a)
= Modernejsi izgled, veC zmogljivosti
= KompleksnejSa uporaba

= Kljub temu pa Microsoft Query ponavadi zadosca



Python in dostop do podatkovnih baz

Python
l
DB API 2.0 (PEP 249)
l l \
pymysql cx_Oracle pyodbc

' '
pymssql psycopg?2




pyodbc — implementacija ODBC za Python

= pyodbc je modul za Python ki omogoca dostop do poljubnega
SUPB (ki podpora ODBC)

» implementira Python Database API Specification v2.0 z dodatki, ki
poenostavljajo delo s SUPB

= pyodbc je odprtokoden, uporablja MIT licenco, in ga lahko zastonj]
uporabljamo tako v pridobitne, kot nepridobitne namene (vkljucno
Z izvorno kodo)

» domaca stran in dokumentacija:
https://github.com/mkleehammer/pyodbc/wiki




Osnovni gradniki pyodbc

= Uvoz modula:
import pyodbc

= Najpomembnejsi razredi:
— Povezava (connection)
— Kurzor (cursor) in rezultat (result)
— Podatkovni tipi in njihovi konstruktorji
— Obravnava napak

= Postopek dela
— ustvarimo povezavo
— ustvarimo kurzor na povezavi
— s kurzorjem izvedemo poizvedbo in dobimo rezultat
— iteriramo po rezultatu (vrsticah)



pyodbc: povezava

= Povezavo c ustvarimo z ukazom:
¢ = pyodbc.connect(ConnectionString)

= ConnectionString doloca povezavo, npr.
ConnectionString = 'DSN=FRI;UID=pb;PWD=pbvaje'
ali
ConnectionString = 'DSN=DOMA;UID=pb;PWD=pbvaje'
= ConnectionString bi lahko napisali tudi brez definiranega DSN:
ConnectionString = 'DRIVER={MySQL ODBC X.Y driver},;
SERVER=localhost; DATABASE=vaje;UID=pb;PWD=pbvaje;
CHARSET=UTF8'



pyodbc: povezava

= Povezava c ponuja metode:

= close(): zapri povezavo, enako pri destruktorju objekta
— c.close()

= commit(): uveljavi transakcijo (Ce SUPB podpira)
— c.commit()

= rollback(): razveljavi transakcijo (Ce SUPB podpira)
— c.rollback()

= cursor(): vrne nov kurzorski objekt, ki uporablja povezavo c
— cursor = c.cursor()



pyodbc: kurzor

= Kurzor x ustvarimo z ukazom:
X = c.cursor()

= Nekateri atributi:
— description: opis stolpcev rezultata (shema)
— rowcount: Stevilo vrstic rezultata

= Nekatere metode:
— execute(ukaz, [parametri]): izvede ukaz z opcijskimi parametri
— fetchall(): prenese vse vrstice rezultata
— fetchone(), fetchmany(size): preneseta eno ali vec vrstic



Jadralec(jid, ime, rating, starost)
Coln(cid, ime, dolzina, barva)
Rezervacija(jid, cid, dan)

pyodbc: kurzor

= Po kurzorju lahko iteriramo, vendar samo enkrat:

x.execute(SQLukaz)
for r in x: print(r)
= Vec iteracij: v = x.fetchall(), nato iteriramo po v

= Parametri v SQL ukazih:
— Primer: SELECT * FROM jadralec
— SQL ukaz kot niz znakov: Pythonov nacin parametrizacije
= x.execute('SELECT %s FROM %s' % ('*', 'jadralec'))
— pyodbc prenos parametrov v metodi execute:
= ? oznacuje parameter
= seznam parametrov za ukazom
= x.execute('SELECT ? FROM ?, "*', jadralec')
= x.execute('SELECT ? FROM ?, (**', jadralec'))



pyodbc: obravnava napak

= Razredi pyodbc ob napakah javljajo naslednje izjeme:

DatabaseError
DataError StandardError
OperationalError |__Warning
) | __Error
IntegrityError | __InterfaceError
InternalError r | __DatabaseError
__DataError

ProgrammingError

__OperationalError
NotSupportedError

|

|

| __IntegrityError

| __InternalError

| __ProgrammingError
| __NotSupportedError

pyodbc/ DB API 2.0
A



pyodbc: obravnava napak

try:
x.execute ( SQLukaz)

except pyodbc.DataError:
-- obravnava napake
pass

except pyodbc.DatabaseError:

-- obravnava napake
pass

except:

-- obravnava ostalih napak
pass



pyodbc: preslikava med ODBC/SQL in

Pythonovimi podatkovnimi tipi
ODBC Python
char varchar longvarchar string
GUID
wchar wvarchar :
wlongvarchar unicode
smallint integer tinyint int
bigint long
decimal numeric decimal
real float double double
date datetime.date
time datetime.time
timestamp datetime.datetime
bit bool




Java in dostop do podatkovnih baz

= Sun Java: Ze od vsega zacCetka nhamenjena pisanju poslovnih aplikacij in apletov

= Enostaven vgrajen SUPB (JavaDB: Apache Derby, 100% javanski SUPB) kmalu
ni veC dovolj

= Potreben vmesnik za dostop
do podatkov tako na strani
streznika kot odjemalca

\
4

Oracle
Sun



Java Database Connectivity - JDBC

= Objektno usmerjena UDBC En:blec Aplications |
implementacija v duhu ODBC

= Arhitektura prakticno identiCna
LN
\/

ODBC
= Aplikacija potrebuje JDBC
aplikacijski vmesnik (del BRE T

javanskega standarda) in JDBC grCL Lriver
gonilnik za konkretno bazo

= V Javi 1.4 se pojavi JDBC 3.0
= V Javi 6 se pojaviJIDBC 4.0

= V Javi 7/8/9 se pojavijo JDBC 4.1,
JDBC 4.2, JDBC 4.3 (inkrementalne
dopolnitve standarda)

@@



Uporaba JDBC gonilnikov

= Kaj potrebujemo za delo:

— JDBC razrede (java.sql.*)

— JDBC gonilnik (.jar arhiv, inst. lokacija odvisna od proizvajalca SUPB)
= Tipi JDBC gonilnikov

— Tip 1, JDBC-ODBC most: preslika klice JDBC metod v ODBC klice procedur. Primerno le kadar
nimamo JDBC gonilnika (Java 8, JDBC 4.2
ga veC ne podpira!)

— Tip 2, Native-API: kli¢e direktno API gonilnika za PB na nasem sistemu. Neprenosljivo.

— Tip 3, network-protocol: preko mreze dostopa z SUPB-neodvisnim protokolom do posrednika
na strezniku (middleware), ki protokol pretvori v taksne klice, ki jih ciljni SUPB razume

— Tip 4, native-protocol: direktno preko mreze dostopa do SUPB z uporabo njemu lastnega
protokola
= Tipa 1 in 2 sta hibridna (Java/ strojna koda), tipa 3 in 4 pa sta pisana v Cisti
Javi in zato maksimalno prenosljiva.



Dostopnost JDBC gonilnikov

* Ponuja jih vecCina proizvajalcev sodobnih SUPB in tudi nekateri
samostojni razvijalci

= Baza JDBC gonilnikov (neuradna):

— http://mvnrepository.com/tags/jdbc (Apache Maven repository)

» Nekateri veliki proizvajalci (JDBC 4.2/4.3):
— Oracle: zraven klienta, JDBC tip 2 ali 4

http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/index.html

— Microsoft: JDBC tip 4

http://msdn.microsoft.com/en-us/data/aa937724.aspx

— MySQL: npr. Connector/J JDBC tip 4

http://www.mysgl.com/products/connector/




Priprava sistema

= Instaliramo in lociramo JDBC gonilnike:
— Oracle: vklju€eni s klientom, instalira se na npr. \sqldeveloper\jdbc\lib\ojdbc10.jar

— MySQL: potreben prenos dodatka Connector/], katerega .jar datoteko skopiramo na
primerno lokacijo

= Popravimo sistemsko spremenljivko CLASSPATH tako, da vkljucuje
omenjeno lokacijo (odvisno od uporabljenega SUPB), ali pa lokacije
eksplicitno vklju¢imo v projekt



Predstavitev preprostega JDBC programa

DriverManager

creates

>

. creates creates
Connection > Statement > ResultSet
A
SQL data
Y
Establish link to DB : ) 15\
> i Driver ;

Database




Pisanje JDBC programa

Napovej uporabo potrebnih razredov

Nalozi JDBC gonilnik s pomocjo objekta DriverManager
Identificiraj vir podatkov (data source)

Kreiraj objekt za povezavo s PB (Connection).

Kreiraj objekt, ki predstavlja SQL stavek (Statement).
Izvedi poizvedbo z uporabo Statement objekta.
Mnozico rezultatov preberi iz vrnjenega ResultSet objekta.
Zapri objekt ResultSet.

. Zapri objekt Statement.
10 Zapri objekt Connection.

OO NV AW



Napoved uporabe potrebnih razredov

import java.sql.*;
ali bolj eksplicitno

import java.sqgl.Connection;

import java.sql.DriverManager;
import java.sql.SQLException;
import java.sqgl.Statement;

import java.sgl.ResultSet;

import java.sgl.ResultSetMetaData;



Nalaganje JDBC gonilnika

= Za vsak SUPB ima gonilnik svoje ime

= Za Oracle:
— Class.forName("oracle.jdbc.driver.OracleDriver");

= Za MySQL.:

— Class.forName("com.mysql.jdbc.Driver");



Kaj v resnici naredi Class.forName

= Class
— dinamic¢no nalaganje javanskih razredov med izvajanjem

= Class.forName("x.y.z")

— Poisce paket x.y in iz njega naloZi razred "z". Ce je nalaganje razreda "z" uspesno,
pozene njegovo staticno inicializacijo.

= Za MySQL:
— Class.forName("com.mysql.jdbc.Driver");
— nalozi razred Driver, kjer se v statiCni inicializaciji izvede naslednja koda:

java.sql.DriverManager.registerDriver(new Driver());



Identifikacija vira podatkov

= Specifikacija s povezovalnim nizom
— Zgradba niza:
jdbc:protokol:identifikacija vira podatkov
= Za Oracle:
— sourceURL = "jdbc:oracle:thin:@racunalnik:port:baza";
— Obicajna stevilka porta je 1521
= MySQL:
— sourceURL = "jdbc:mysql://racunalnik:port/baza";
— Obicajna stevilka porta je 3306



Kreiranje povezave s PB

= Preko DriverManagerja:

Connection databaseConnection =
DriverManager.getConnection(sourceURL, username, password);

= Preko DataSource vmesnika (z uporabo Java Naming and Directory
Interface - JNDI)

VendorDataSource ds = new VendorDataSource();
ds.setServerName("Our_Database_Server_Name");
ds.setDatabaseName("Our_Database_Name";;

ds.setDescription("Our database description");

4

ébnnection databaseConnection =

ds.getConnection("username”, "password");



Kreiranje in izvajanje SQL stavka

— Statement statement =
databaseConnection.createStatement();

— ResultSet result = statement.executeQuery("SELECT ...");

= Obstajajo Se druge vrste stavkov

— PreparedStatement (vnaprej pripravljena poizvedba, primerno za veckratno
izvajanje s posredovanjem vhodnih — IN - parametrov)

— CallableStatement (klici shranjenih procedur v bazi s posredovanjem vhodnih — IN —
in izhodnih — OUT - parametrov)



Obdelava mnozice rezultatov

1. Izpis meta-podatkov (imena stolpcev)
ResultSetMetaData md = result.getMetaData();

for (int i=1; i<=md.getColumnCount(); i++) {
System.out.print(md.getColumnLabel(i)+"\t");

¥
System.out.printin();

2. Izpis dejanskih rezultatov (vrednosti atributov)
while (result.next()) {
for (int i=1; i<=md.getColumnCount(); i++) {
System.out.print(result.getString(i)+"\t");

¥
System.out.printin();

}



Delo z rezultati (ResultSet)

ResultSet result = statement.executeQuery("SELECT ...");

Prehajanje med vrsticami rezultata:
e Metodi first() in last ()
e Metodi previous() in next(): prehod na predhodno/naslednjo vrstico

e Metode za dostop do vrednosti atributov, npr:
e getString("ime atributa) ali getString(pozicija atributa)
e Razlicne metode (glede na vnaprej znan tip atributa)

getAsciiStream() getTimestamp () getTime ()
getBoolean () getBinaryStream/() getsString ()
getDate () getBytes () getByte ()
getInt () getFloat () getDouble ()

getShort () getObject () getLong ()




Preslikava podatkovnih tipov

Java Object/Type JDBC Type
Int INTEGER
Short SMALLINT
Byte TINYINT
Long BIGINT
Float REAL
Double DOUBLE
java.math.BigDecimal NUMERIC

Boolean
String

Clob

Blob

Struct

Ref
java.sql.Date
java.sql.Time
java.sql.Timestamp
java.net. URL
Array

byte[]

Java class

BOOLEAN or BIT

CHAR, VARCHAR, or LONGVARCHAR
CLOB

BLOB

STRUCT

REF

DATE

TIME

TIMESTAMP

DATALINK

ARRAY

BINARY, VARBINARY, or LONGVARBINARY
JAVA_OBJECT




Obravnava napak

= Class.forName("Ime gonilnika") ob napaki mecejo
ClassNotFoundException

= Ostale JDBC metode ob napaki mecejo SQLException

= Zato moramo te napake obravnavati:
try {
.... // JDBC Klici
} catch(ClassNotFoundException cnfe) {
System.err.printin(cnfe);
} catch(SQLException sgle) {
System.err.printin(sqgle);

}



Primer dostopa do podatkov

import java.sql.*;

public class TestJDBC1l {
public static void main(String[] args) {
try {

String sourceURL;

Connection databaseConnection;

if ('true) { // Oracle
Class.forName ("oracle. jdbc.driver.OracleDriver") ;
// Create a connection through the DriverManager

sourceURL =
"jdbc:oracle:thin:@todo.fri.uni-1j.si:1521:vaje";
} else { // MySQL
Class. forName ("com.mysqgl. jdbc.Driver") ;
// Create a connection through the DriverManager

sourceURL = "jdbc:mysql://localhost:3306/vaje";
}
databaseConnection =
DriverManager.getConnection
(sourceURL, "pb", "pbvaje");

System.out.println ("Connection is: "+databaseConnection) ;



Primer dostopa do podatkov

Statement statement = DatabaseConnection.createStatement () ;

ResultSet result = statement.executeQuery
("SELECT * FROM jadralec");

// Meta podatki
ResultSetMetaData md = result.getMetaData() ;
int count = md.getColumnCount() ;
for (int i=1l; i<=count; i++)
System.out.print (md.getColumnLabel (i) +"\t") ;
System.out.println() ;
// Izpis v tekstovni obliki
while (result.next()) {
for (int i=1l; i<=count; i++)
System.out.print (result.getString(i)+"\t");
System.out.println() ;
}
// Zapri ResultSet , Statement, Connection
result.close(); statement.close(); databaseConnection.close() ;
} catch(ClassNotFoundException cnfe) {
System.err.println(cnfe) ;
} catch(SQLException sqgle) {
System.err.println(sqle) ;

}



Kje lahko uporabljamo JDBC

= Poljubna aplikacija (JApplication) v Javi
— Ob uporabi gonilnikov tretje ali ¢etre skupine (Cista java) so aplikacije poljubno
prenosljive
= Poljubni apleti (JApplet) ali servleti

— Ob uporabi gonilnikov tretje ali Cetre skupine (Cista java) so aplikacije poljubno
prenosljive

— Moznost pisanja popolnoma prenosljivih in spletnih aplikacij, ki dostopajo do PB
= V kontekstu tehnologij upravljanja podatkov:

— Izvajanje podatkovnih operacij, ki v SQL niso mogoce, so nerodne ali premalo
ucinkovite (predprocesiranje, zapleteni izracuni, ... nad podatki v PB)



